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ABSTRACT
The TLA2024EVM-PDK is comprised of the TLA2024 Evaluation Module (EVM) and the PAMBoard
motherboard. The combination of the EVM and PAMBoard allows users to evaluate the functionality of the Texas
Instruments 12-bit TLA2024 device. The TLA2024 is an ultra-small, low-power analog-to-digital converter (ADC).
The TLA2024 has inputs that can be configured as four single-ended or two differential inputs. This document
describes both the EVM hardware platform and the graphical user interface (GUI) software used to configure
and operate the device. The user’s guide also includes the EVM schematic diagram, board layout, and bill of
materials. The EVM-PDK platform eases the evaluation of the TLA2024 device with hardware, software, and
computer connectivity through the universal serial bus (USB) interface.
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1 Introduction
The TLA2024EVM-PDK is a fully-assembled evaluation platform designed to highlight the TLA2024 features and
modes of operation that make this device suitable for low-power applications. The EVM sits on top of an
accompanying Precision ADC Motherboard (PAMBoard) used as a USB-to-PC GUI communication bridge. The
board combination also serves as an example implementation of connecting a microcontroller (MCU) to
communicate with the TLA2024 device through an Inter-Integrated Circut interface (I2C).

Note

The TLA2024 EVM requires an external controller to evaluate the TLA2024 device.

The PAMBoard is controlled by commands received from the TLA2024EVM-PDK GUI, and returns data to the
GUI for display and analysis. If the PAMBoard is not used, the EVM plug-in module format allows for an
alternative external host to communicate with the TLA2024 by connection through the pin headers J1 through
J4. Connections to the header are identified on the PCB silkscreen and listed in Table 3-1.

The combined TLA2024EVM and PAMBoard make up the TLA2024EVM-PDK and incorporates the following
features:

• TLA2024, four input-channel ADC with header or screw terminal block input connections
• Voltage selection of 3.3 V or 5 V operation for the TLA2024 with level-shifting to the 3.3-V MCU
• Full-scale ranges from 256 mV to 6.144 V
• I2C for communication and configuration
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interface
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Figure 1-1. TLA2024EVM-PDK Functional Block Diagram
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2 Quick Start
The quick start shows a minimalist startup process to get the GUI working with the EVM and to see a simple
example for data collection. Details on each step are found elsewhere within the user's guide. Specifics
regarding the GUI installation steps are found in Section 4.2.

2.1 Step 1 - Hardware Setup
The EVM hardware configuration consists of verifying the supply settings and adding a source voltage to be
converted.

1. Verify that the TLA2024 supply voltage is set to the 5-V setting at JP1.
2. Connect an input voltage to AIN0. The PAMBoard supply voltage can be used as a voltage source to the

TLA2024. Use the 3.3-V source found at header J1 pin 1 and with a wire jumper connect to the J6 header at
pin 1 (A0).

Figure 2-1. Hardware Setup

2.2 Step 2 - USB Connection and GUI Startup
The TLA2024EVM GUI software can be run from a browser window. Additional software may need to be
installed if not installed previously. See Section 4.2 for additional details. Once the GUI has started, plug the
TLA2024VM-PDK into an available USB port on the PC.
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2.3 Step 3 - Configuration and Data Collection
Once the GUI has recognized the EVM, go to the chart window as identified in Figure 2-2.

1. Open the slide-out configuation from the right side of the GUI and Show Capture Settings. Select the MUX
input for AINP = AIN0 and AINN = GND from the Select MUX Channels drop-down menu selection.

Figure 2-2. Capture Setting – MUX
2. Select the FSR = ±4.096V from the Select FSR drop-down menu as shown in Figure 2-3. The selection is

needed to increase the full-scale range to measure the 3.3-V input.

Figure 2-3. Capture Setting – Full-Scale Range (FSR)
3. Close the slide-out configuration window by selecting Hide Capture Settings.
4. Choose Volts from the chart window for the Y-axis drop-down menu. See Figure 2-4.
5. Press the COLLECT DATA button to capture the data.
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6. The collected data appears in the chart window once the collection completes.

Figure 2-4. Data Capture
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3 TLA2024EVM-PDK Overview
Various onboard components are used to interface the analog input, digital interface, and provide power to the
TLA2024 device. The functional block diagram shows a TLA2024EVM-PDK board overview.

3.1 TLA2024EVM-to-PAMBoard Interface
The TLA2024 supports the digital I2C and functional modes as detailed in the TLA2024 Ultra-Small, 12-Bit
Analog-to-Digital Data Sheet. The PAMBoard operates at a 3.3-V logic level and the digital I/O lines of the ADC
are level shifted to match the operating voltage of the TLA2024.

Digital interface connections to the PAMBoard include power and I2C for communication. The digital connections
are highlighted in the silkscreen as shown in Figure 3-1. Details regarding the connections are shown in Table
3-1.

Figure 3-1. TLA2024EVM-to-PAMBoard Connections

Table 3-1. TLA2024EVM-PDK Header Pinout and Description
Description Connector Connector Description Description Connector Connector Description

+3.3 V J1:1 J3:21 +5 V J4:40 J2:20 GND

J1:2 J3:22 GND J4:39 J2:19

J1:3 J3:23 J4:38 J2:18

J1:4 J3:24 J4:37 J2:17

J1:5 J3:25 J4:36 J2:16

J1:6 J3:26 J4:35 J2:15

J1:7 J3:27 J4:34 J2:14

J1:8 J3:28 J4:33 J2:13

I2C SCL J1:9 J3:29 J4:32 J2:12

I2C SDA J1:10 J3:30 N/A J4:31 J2:11
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3.2 Digital Interface
As noted in TLA2024EVM-to-PAMBoard Interface, the TLA2024 interfaces with the PAMBoard. The PAMBoard
communicates with the computer over USB. The two devices on the EVM requiring communication are the
TLA2024 ADC (U1) and the electrically-erasable programmable read-only memory (EEPROM) (U3) using I2C
(see Figure 6-5). The EEPROM is preprogrammed with the information required to configure and initialize the
TLA2024EVM-PDK GUI software platform. Once the hardware is initialized through the software, the EEPROM
is no longer used.

The PAMBoard and EEPROM (U3) use 3.3 V for the device interface logic levels. The TLA2024 can operate at
either 3.3 V or 5 V as desired by jumper selection JP1. To allow the TLA2024 to operate at 5-V logic levels, a
logic level translator (U2) is used.

3.3 Analog Input Connections
The TLA2024 device is designed for easy interface to an external sensor that is differential or single-ended using
either a header (J6) or a screw terminal block (J5). Connector J6 provides an easy interface connection for
differential input pairs with each pair separated by analog ground. Table 3-2 lists the channel input connections
for J5 and Table 3-3 shows the input connections for J6. Both connectors are clearly labeled on the PCB
silkscreen for easy input connection identification.

Connector J5 is a screw terminal block for attaching an external sensor with bare wire connections. The terminal
block includes all four inputs and a connection point for analog ground. See Figure 3-2 for the input layout.

Table 3-2. Terminal Block Input (J5)
J5 Terminal Block Inputs Description

J5:1 Analog input for AIN0 of the ADC

J5:2 Analog input for AIN1 of the ADC

J5:3 Analog input for AIN2 of the ADC

J5:4 Analog input for AIN3 of the ADC

J5:5 Analog Ground

Figure 3-2. Analog Input Terminal Block (J5)

Connector J6 is a 100-mil spaced dual-row header. Jumper wire or clip leads can be used for connections. The
header includes all four inputs and two analog ground connections. See Figure 3-3 for the input layout.

Table 3-3. Terminal Block Input (J6)
J6 Terminal Block Inputs Description

J6:1 Analog input for AIN0 of the ADC

J6:2 Analog input for AIN1 of the ADC

J6:3 and J6:4 Analog Ground

J6:5 Analog input for AIN2 of the ADC

J6:6 Analog input for AIN3 of the ADC
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Figure 3-3. Analog Input Header (J6)

Each analog input includes a single-order low-pass filter. The single-ended input filter cutoff frequency is 67.9
kHz. Up to four separate single-ended measurements are possible.

Instead of single-ended measurements, up to two differential input pair combinations are possible. The filter
design for the differential input pair filtering has a cutoff frequency of 3.4 kHz. The filter is populated on the
TLA2024EVM-PDK for input pair combinations of AIN0 and AIN1 or AIN2 and AIN3. The input combination of
AIN1 and AIN2 is possible by adding a 47-nF capacitor at C6 (see location in the schematic).

CAUTION
The configuration options for the TLA2024 allow for a potential full-scale range (FSR) greater than
the supply. This is useful when an input voltage slightly exceeds the next lower FSR. However, the
input voltage should not exceed the range of the VDD supply selected at JP1. The absolute input
voltage is bounded by VDD + 0.3 V and GND – 0.3 V. Damage to the TLA2024 may occur if the
absolute input range is exceeded.
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3.4 Power-Supply Options
The TLA2024 supports a wide range of supply voltage from 2 V to 5.5 V. The TLA2024EVM ADC voltage (VDD)
can operate from either 3.3 V or 5 V. The power is supplied from the USB 5-V source to the PAMBoard.
However, the USB power supply voltage is not consistent from PC to PC. A DC/DC converter increases the USB
output to 5.5 V. A linear low drop out (LDO) regulator uses the 5.5 V to establish a clean and stable 5 V and 3.3
V for the TLA2024EVM-PDK.

When the USB cable is plugged into the PC, two LEDs will light on the PAMBoard (see Figure 3-4). The bottom
LED (D5) indicates that the 5-V output is active. The top LED (D1) indicates that the TLA2024EVM-PDK is ready
to communicate with the GUI.

Figure 3-4. LED Indicators D1 and D5

Jumper JP1 selects the operating voltage for the TLA2024 (see Figure 3-5). When jumper JP1 is in the bottom
position, the VDD to the TLA2024 is set to 5-V and when in the top position, the VDD supply is set 3.3-V.

Figure 3-5. TLA2024 Supply Setting Jumper (JP1)
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4 TLA2024EVM-PDK Setup and Operation
The TLA2024EVM-PDK requires a communication driver and GUI software for device configuration and data
collection. Driver installation is automatic. The USB enumerates as a composite device for Communications
Device Class (CDC) and Bulk. The sending of commands is through CDC while data collection is by Bulk
transfers from the PAMBoard. Additional information regarding any driver issues is located within this FAQ.

4.1 EVM Plug-in Instructions
Install jumper JP1 to the desired TLA2024 operating voltage. Connect the USB micro cable to the PAMBoard
and attach the other end of the cable to an available USB port on the PC.

4.2 TLA2024EVM-PDK GUI and TI Cloud Agent Installation
The following steps describe the TLA2024EVM GUI software installation:

1. Verify that the micro USB to USB cable from the PAMBoard to a USB port on the computer is connected.
2. On the EVM landing page (TLA2024EVM-PDK), the software is available through a web-based GUI.

Connecting to the GUI may require a login to a user account for access (Software GUI).
3. First-time users may be prompted to download and install the browser extension for Firefox™ or Chrome™

and the TI Cloud Agent Application as shown in Figure 4-1. Installing the TI Cloud Agent is a one time
download and installation.

4. Refresh the GUI. The GUI should connect to the hardware. A green signal displays, and the Hardware
Connected indication shows on the bottom (see Figure 5-3).

Figure 4-1. Browser Extension and TI Cloud Agent Installation
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5 TLA2024EVM-PDK GUI
The Home page is the GUI start-up landing page. The Home page provides a high-level overview of the
TLA2024 device. The horizontal menu bar at the top of the GUI shows the menu options:

• File
• Options
• Tools
• Help

Figure 5-1. Menu Bar Options

The upper corner of the GUI shows vertical tabs available to navigate through the various GUI displays. The
vertical tabs starting at the top icon include:

• Home
• Chart
• Configuration
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Figure 5-2. GUI Navigation Bar Options

The black ribbon at the bottom of the GUI shows connection status and log information. On GUI startup, the
software attempts to identify and verify that the EVM connected matches with the GUI. An EEPROM on the
TLA2024EVM-PDK contains information specific to the EVM connected. A properly connected and identified
EVM displays as Device Connected with a green indicator and at the bottom as Hardware Connected in the
status ribbon.

Figure 5-3. TLA2024 EVM Connected GUI
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5.1 Menu Bar
The Menu bar across the top of the GUI displays the device name used on the EVM along with a number of
drop-down menu options.

5.1.1 File Menu

The File drop-down menu displays available options. The options include:

• Program Device
• Analysis Data

– Save data
– Load data

• Register Data
– Save register settings
– Load register settings

Figure 5-4. File Menu

The Program Device option should only be necessary if an important firmware change is required. If
reprogramming the PAMBoard firmware becomes necessary, an additional pop-up box displays with information
on the programming procedure.

By using the Save data option the Analysis Data is saved to a comma-separated values (CSV) formatted file for
further analysis using external programs. The data can also be loaded back into the GUI for further review or
analysis by selecting Load data.
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Figure 5-5. Analysis Data Options

Register Data can be saved for a particular configuration by selecting Save register settings. A previously-saved
configuration can be loaded back into the GUI again when testing various device configurations by using Load
register settings.

Figure 5-6. Register Data Options
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5.1.2 Options Menu

The Options drop-down provides information regarding the serial COM port the GUI is using. By selecting Serial
Port, the serial COM port information displays the current COM port settings in a pop-up dialog with options to
change the COM port or reconfigure the settings as necessary.

Figure 5-7. Options Menu

Figure 5-8. Serial Port Configuration Settings

www.ti.com TLA2024EVM-PDK GUI

SBAU368 – FEBRUARY 2021
Submit Document Feedback

TLA2024EVM-PDK User's Guide 17

Copyright © 2021 Texas Instruments Incorporated

https://www.ti.com
https://www.ti.com/feedbackform/techdocfeedback?litnum=SBAU368&partnum=TLA2024,


5.1.3 Tools Menu

The Tools drop-down menu displays the Log pane option. The Log pane displays the activity information log at
the bottom of the GUI. The Log pane displays the same information as when clicking the book icon in the status
ribbon.

Figure 5-9. Tools Menu

Figure 5-10. Logs Display
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5.1.4 Help Menu

The Help drop-down menu displays the following:

• E2E Support Forum providing a link to the E2E forum for asking questions or searching the E2E forum.
• View README.md displays pertinent startup information not necessarily included in this guide.
• About displays specific information regarding the GUI and EVM hardware.

Figure 5-11. Help Menu
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Information specific to the GUI build and the connected hardware is found by selecting About from the drop-
down Help menu.

Figure 5-12. Help Information (About)
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5.2 Navigation Bar

5.2.1 Home

The Home page includes links to a variety of information. The links include this user’s guide, the EVM
schematic, as well as support resources. Next to the connection status indicator is an information icon. Clicking
the icon displays specific information regarding the TLA2024EVM-PDK.

Figure 5-13. Connected Hardware Information

At the bottom of the GUI is a black ribbon with status information. The status shows if the hardware successfully
connects to the PC and the COM port used. The status ribbon displays regardless of the navigation page
selected.

5.2.2 Chart

The Chart icon selects the available charting options for displaying conversion data. The data options include a
Time Domain, Histogram, and FFT displays.

The Chart tab allows configuration of the Data Capture for the TLA2024. At the upper right of the capture
window is the setting for the number of Samples to collect. To capture data, press the Collect Data button
displayed at the upper corner of the window.
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Figure 5-14. Data Capture Window

Conversion data collects when the Collect Data button is pressed. The button will change to Stop Collect and by
pressing the button while in this state the collection of conversion data will stop, otherwise the data is collected
for the number of Samples as given. The number of Samples can be changed prior to pressing Collect Data by
selecting the Samples and directly entering the desired number of samples or by clicking on the up and down
arrows. The number of samples cannot be changed while the data is being collected.

When the Collect Data operation is complete, the data will display with the calculated channel statistics and a
plot of the data in the chart window. Various icons for viewing the data include zoom, pan, and home. The home
icon restores the graph to show all data collected. The viewing icons are underneath the statistics information on
the right side of the GUI.

Also on the right side of the chart window is a slide-out menu where configuration settings are displayed and
changes can be made for data collection.

5.2.2.1 Channel Statistics

When data collection completes, statistical information displays along with the charted data. The statistical
display for Time Domain and Histogram are the same, but the FFT statistics differ. As the TLA2024 is primarily a
DC measurement device, the FFT plot and information may have little meaning.

5.2.2.1.1 Time Domain and Histogram Statistics

The Time Domain and Histogram plots share the same statistical information:

• Input Channels selected
• Min code within the data set
• Max code within the data set
• Mean code value within the data set
• Std Dev representing the standard deviation within the data set
• Pk-to-Pk representing the total noise peak-to-peak within the data set
• Eff. Res representing the effective resolution as number of bits with the value in parenthesis showing the

noise-free number of bits
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Figure 5-15. Capture Statistics

5.2.2.1.2 FFT Statistics

The FFT plot displays the following statistics:

• Input Channels selected
• Fundamental frequency
• Fundamental power
• Noise floor
• SNR or signal-to-noise ratio
• SFDR or spurious free dynamic range
• THD or total harmonic distortion
• SINAD or signal-to-noise and distortion
• ENOB or effective number of bits
• Harmonics
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Figure 5-16. FFT Statistics

5.2.2.2 Time Domain Plot

The Time Domain plot displays the sample count number in the X-axis. The Y-axis is displayed as either codes
or volts with the selection in a drop-down menu. The Y-axis drop-down menu displays next to the charting icons
near the right side of the GUI below the statistics.

Figure 5-17. Time Domain Plot
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5.2.2.3 Histogram Plot

The Histogram plot shows the number of occurrences a code or group of codes appear. User selection includes
a choice of:

• # of Bins selecting the number of bins to include in the plot
• Bin Size selecting the number of unique codes to include in each bin

Figure 5-18. Histogram Plot

The # Bins and Bin Size are selectable options and display next to the charting icons near the right side of the
GUI below the statistics.
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5.2.2.4 FFT Plot

The FFT plot is rather meaningless for DC input voltages. However, a low-frequency AC signal can be analyzed
and the FFT plot displayed.

Figure 5-19. FFT Plot
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5.2.2.5 Capture Configuration Settings

A slide-out menu is viewable on the right side of the Chart window. By clicking the slide-out for Show Capture
Settings various configurations display and are selectable. The drop-down menu Capture Settings are:

• Select data rate for the data output conversion rate
• Select MUX channels by choosing the desired input channels to be converted
• Select FSR for choosing the voltage input measurement range

Figure 5-20. Capture Settings

5.2.3 Configuration

The Register Map window contains information about the configuration and the last conversion data from the
TLA2024 device. The Conversion register contains the value of the last 12-bit conversion result read from the
TLA2024. The conversion data are 12-bit left-justified in the 16-bit register.

As the TLA2024 is a programmable device, the Config register is the only programmable register and is 16 bits
in length.

A number of control buttons and drop-down menus exist to configure the Register Map read and write operations
when data are written and read from the TLA2024.

Throughout the Register Map window question mark icons appear. Clicking on these icons open details
pertaining to the items in the locations where they appear.
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Figure 5-21. Register Map

The GUI displays two registers even though there is only one configurable register in the TLA2024 device. For
the firmware to remain in synchronization with the GUI, all communication is first directed to a pointer register
internal to the device and either points to the conversion register or the configuration register.

Configuration of the TLA2024 device is accomplished using the drop-down menu and click options shown in the
Field View on the right side of the GUI window. It is also possible to double-click on the various bits to toggle the
bit settings. As the bit settings change, the Field View options will also change to correspond to the selection.

Figure 5-22. TLA2024 Configuration
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5.2.3.1 Register Read and Write Options

At the top and right side of the Register Map window are controls for reading and writing to the registers. The
startup default control values are to Immediately Write the Config register when options change. The Auto Read
register function is turned off.

Figure 5-23. Register Read and Write Controls
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5.2.3.1.1 Read Register Options

The default GUI configuration is to have the Auto Read functionality turned off and instead manually read the
registers using the READ REGISTER and READ ALL REGISTERS buttons. The READ REGISTER button reads
only the selected register. The READ ALL REGISTERS button reads all registers available for the TLA2024
device. The advantage of manually reading the register contents is a reduction in USB communication between
the TLA2024EVM-PDK and the GUI.

The registers can be read automatically from the TLA2024 at a variety of intervals from once a second to as fast
as possible. The intervals can be seen and selected by using the Auto Read drop-down menu selection. The
READ REGISTER and READ ALL REGISTER button options are only enabled when the Auto Read selection is
turned off.

Figure 5-24. Auto Read Options
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5.2.3.1.2 Write Register Options

The GUI default option for register writes is Immediate Write. When Immediate Write is selected, any register
configuration changes are immediately written from the GUI to the TLA2024 device. Using the Immediate Write
option ensures that what is being displayed is what is configured in the TLA2024.

If the write register drop-down menu selection is for a Deferred Write, then the write register buttons WRITE
REGISTER and WRITE ALL REGISTERS become enabled. Similar to the functionality of the read register
buttons, the WRITE REGISTER button will write the configuration for the currently selected register. When
selecting the WRITE ALL REGISTERS button all configurable registers will be written.

Figure 5-25. Register Write Options
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5.3 Connection Status
Connection status shows at the bottom of the GUI in the black status ribbon. At the left side of the status ribbon
is a book icon that when selected, allows for the log information to be displayed. Next to the book icon is a
connection icon. The icon is showing the visual representation of the connection status also displayed as text.
The icon shows as a connected link when the EVM and GUI are connected, and appears as a broken link when
not connected. Clicking on the icon will attempt to connect if disconnected and will disconnect if the EVM is
currently connected. The last icon shows as an arrow and clicking the icon toggles the display of connection
details.

Figure 5-26. Status Information
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6 Bill of Materials, Printed Circuit Board Layout, and Schematics
This section contains the TLA2024EVM-PDK bill of materials (BOM), printed-circuit board (PCB) layout, and
board schematic.

6.1 Bill of Materials
Table 6-1 lists the bill of materials (BOM) for the TLA2024EVM-PDK.

Table 6-1. Bill of Materials
Designator QTY Description ManufacturerPart Number Manufacturer

C1, C2, C3, C4 4 CAP, CERM, 4700 pF, 50 V, +/- 5%, X7R, 0603 C0603C472J5RACTU Kemet

C5, C7 2 CAP, CERM, 0.047 uF, 50 V, +/- 10%, X7R, 0603 C1608X7R1H473K080AA TDK

C8, C10, C11,
C12

4 CAP, CERM, 0.1 uF, 10 V, +/- 10%, X7R, 0402 CL05B104KP5NNNC Samsung Electro-
Mechanics

C9 1 CAP, CERM, 1 uF, 10 V, +/- 10%, X7S, 0402 C1005X7S1A105K050BC TDK

C13, C14 2 CAP, CERM, 10 µF, 25 V,+/- 5%, X7R, AEC-Q200
Grade 1, 1206

C1206C106J3RACAUTO Kemet

J1/J3, J2/J4 2 Receptacle, 2.54mm, 10x2, Tin, TH SSQ-110-03-T-D Samtec

J5 1 Terminal Block, 3.5mm Pitch, 5x1, TH ED555/5DS On-Shore
Technology

J6 1 Header, 100mil, 3x2, Gold, TH TSW-103-07-G-D Samtec

JP1 1 0.025" SQ Post Header, Through-hole, Vertical, -55
to 125 degC, 2.54 mm Pitch, 3-Pin, Male, RoHS

TSW-103-07-G-S Samtec

R1, R2, R3, R4 4 RES, 499, 1%, 0.1 W, 0603 RC0603FR-07499RL Yageo

R7, R10, R13 3 RES, 10 k, 5%, 0.1 W, AEC-Q200 Grade 0, 0402 ERJ-2GEJ103X Panasonic

R8, R9, R11,
R12

4 RES, 4.70 k, 1%, 0.1 W, 0402 ERJ-2RKF4701X Panasonic

SH-J1 1 Shunt, 100mil, Gold plated, Black SNT-100-BK-G Samtec

TP1, TP2, TP3 3 Test Point, Multipurpose, Black, TH 5011 Keystone

U1 1 12-Bit 3300SPS, 4-Ch Delta-Sigma ADC w/ PGA,
Oscillator, Voltage Reference, & I2C
, RUG0010A (X2QFN-10)

TLA2024IRUGR Texas Instruments

U2 1 TCA9406 Dual Bidirectional 1-MHz I2C-BUS and
SMBus Voltage Level-Translator, 1.65 to 3.6 V, -40
to 85 degC, 8-pin SM8 (DCT), Green (RoHS & no
Sb/Br)

TCA9406DCTR Texas Instruments

U3 1 I2C BUS EEPROM (2-Wire), TSSOP-B8 BR24G32FVT-3AGE2 Rohm

C6 0 CAP, CERM, 0.047 uF, 50 V, +/- 10%, X7R, 0603 C1608X7R1H473K080AA TDK

R5, R6 0 RES, 10 k, 5%, 0.1 W, AEC-Q200 Grade 0, 0402 ERJ-2GEJ103X Panasonic

R14 0 RES, 0, 1%, 0.1 W, AEC-Q200 Grade 0, 0603 RMCF0603ZT0R00 Stackpole
Electronics Inc

TP4, TP5 0 Test Point, Miniature, SMT 5019 Keystone

TP6 0 Test Point, Multipurpose, Red, TH 5010 Keystone
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6.2 Printed Circuit Board Layout
Figure 6-1 to Figure 6-4 depict the TLA2024EVM-PDK PCB layout.

Figure 6-1. Top Silkscreen

Figure 6-2. Top Layer
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Figure 6-3. Bottom Layer

Figure 6-4. Bottom Silkscreen
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6.3 Schematics
Figure 6-5 shows the TLA2024EVM-PDK schematic.
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Figure 6-5. TLA2024EVM-PDK Schematic
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